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1 Notes on documentation 
These instructions are aimed at administrators and users who are familiar 
with the installation and the operation of the software. Read these operating 
instructions prior to commissioning and be sure to keep them accessible for 
later use. Rittal can accept no liability for damage and operating problems 
resulting from non-compliance with these instructions. 
 

1.1 Retention of documents  
These instructions and all other applicable documents constitute an integral 
part of the product. They must be given to the administrator who is 
responsible for the storage of the documents so that they are readily 
available when needed. 
 

1.2 Used symbols and technical terms  
The signal word classifies the effects of a danger in case of non-observance 
of the safety instructions.  

• Note 
Identification of the situations that can lead to incorrect 
configurations or material damage. 

 
The signal words are shown in the following form in the instructions: 
e.g. 
 

 

Signal word! 
1. Description of the danger and its 
effect  
2. Description of the behaviour of the 
user to prevent danger 
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2 Commissioning RiZone 
RiZone is offered as Appliance and as Software Appliance. The 
Commissioning chapter describes the commissioning of both variants. 

2.1 Commissioning the RiZone Software Appliance 
The commissioning of the Software Appliance requires a hypervisor. The 
format of the virtual hard disk is not the same between platforms. The 
following virtualisation solutions are supported: VMware Server and ESX(i), 
Xen and Microsoft Virtual Server. The RiZone Software Appliance 
requires 4 GB RAM, 70 GB hard disk and two CPUs with more than 
2 GHz as resources. Because of the large dependency between the speed 
and the availability of the network interface, we recommend that the 
Software Appliance is given its own network card. 
The RiZone Software Appliance is started from the management tool of the 
virtualisation platform. The RiZone GUI is not yet available after booting. 
For a detailed description of the integration of the virtual hard disk in the 
virtualisation platform, please consult the virtualisation manufacturer's 
documentation. 

2.2 Commissioning the RiZone Appliance 
The installation is performed in accordance with the hardware 
manufacturer's specifications. After switching on the Appliance, the server 
will boot. The required services start automatically. The system is ready. 

2.3 Commissioning RiZone 
The login to the RiZone server is made with the standard user 
Administrator and the password "RiZ0ne!!". We recommend that you 
change the password after the first login. 
RiZone is supplied with the English keyboard layout. If necessary, change 
the keyboard layout after the first login. 

2.3.1 Configuration of the server name, work group, domain 
The configuration is made with the Windows Server 2008R2 operating 
system. The computer name as delivered has the name RiZone1-3. If the 
computer name is changed, a new certificate for RiZone must be created. 
The certificate is created with an additional program. This program is 
available on the server at C:\rizone_install\RittalSSLCfg.exe. 
 

 
Fig. 1  Creating a certificate 
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P (a capital letter must be specified) selects the creation of a certificate for 
productive operation. Press the Enter key to confirm the selection. This 
creates the certificate. 

2.3.2 Network cards configuration 
The Administration menu opens with the Network menu item selected. 
Select the network card to be configured. Select the DHCP/IP settings 
menu item. If a network card configuration with DHCP on is selected, the 
configuration is completed. If the network card configuration with DHCP off 
is selected, a window in which the IP address, the subnet mask and the 
default gateway are entered opens. The DNS server settings are selected. 
As default setting, a tick is set for the Accept DHCP option. If the tick is 
disabled, a window opens in which the primary and the secondary DNS 
servers can be configured. At least the primary DNS server must be 
configured. Click OK to confirm or Cancel to abort. 
If the IP address has been changed successfully, the trap receiver for 
all devices monitored with RiZone must be modified manually. 
It is also possible to modify the IP address of the RiZone server with the 
operating system. IP V6 is disabled in the delivered state. 

2.3.3 Configuration of the Fully-Qualified Domain Name (FQDN) 
If necessary, the FQDN is changed from System properties (system) > 
Computer name > Change > More. This configuration is not necessary if 
the RiZone server is a member of a directory service or the NetBios name of 
the RiZone server can be resolved. 

2.3.4 NTP server configuration 
All components of the RiZone installation must be operated synchronously.  
If the RiZone server is member of a directory service, the NTP server does 
not need to be configured because the directory service makes this 
information available. 
The NTP server is configured manually in the operating system using the 
Change date/time function. 

2.3.5 Database backup 
RiZone has its own internal Microsoft SQL Express database. This database 
is compressed and backed up once per day. The operation of RiZone 
requires that the database backups are deleted regularly from the RiZone 
server. The backups should be stored on an external backup medium. The 
retention time must be changed appropriately depending on the customer 
requirements. 
No local backups will be created if RiZone is operated with an external 
database. 
RiZone runs with a Microsoft SQL Express Edition. The size of a single 
database is limited to 4 GB. 
 

 

Caution! 
Ensure that the databases and drives 
have sufficient free capacity. 

The database backups are stored in the drive of the SQL instance. 
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2.3.6 Updating the RiZone Appliance 
Updates for RiZone are available at the Rittal website. Please obtain 
information about the installation instructions of the updates.  

3 Installation of the RiZone GUI 
The RiZone GUI is installed locally on the client PC. As prerequisite, the 
.NET Framework 3.5 SP1 must be installed. The .Net Framework is 
available at the following URL: 
http://www.microsoft.com/downloads/details.aspx?FamilyID=AB99342F-
5D1A-413D-8319-81DA479AB0D7&displaylang=en 
The installation file of the RiZone GUI is located in the C:\rizone_install\ path 
on the RiZone server. The RiZone administrator must make available the 
installation file. 

3.1 Installing the RiZone GUI 
The Rittal.RiZone v1.xGUI.msi MSI package must be available on the local 
client PC. A double-click executes the file. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig. 2  Installing the RiZone GUI  

 

Click the Next radio button to perform the RiZone installation. 
 
 
 
 
 
 
 
 
 
 
 
 

 
Fig. 3  Installing the RiZone GUI  

 
The licence conditions must be accepted and Next clicked to continue the 
installation process. 
 

8 RiZone 

 

http://www.microsoft.com/downloads/details.aspx?FamilyID=AB99342F-5D1A-413D-8319-81DA479AB0D7&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=AB99342F-5D1A-413D-8319-81DA479AB0D7&displaylang=en


EN

3 Installation of the RiZone GUI 
 

RiZone  9 

 

 
 
 
 
 
 
 
 
 
 
 
 
Fig. 4  Installing the RiZone GUI 
 
The target directory can be changed. The preset target directory is: 
C:\Programme\Rittal\RiZone\ 
Click Next to continue the installation process. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig. 5  Installing the RiZone GUI 
 
Click the Install button to continue the installation process. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig. 6  Installing the RiZone GUI 
 
Click Finish to complete the installation. A link to the RiZone GUI is now 
present on the desktop and a link is available at Programme\Rittal. 
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RiZone's licensing concept provides a high flexibility matched to the needs of 
the end user. The licensing is made using the following criteria: 

• The number of IP nodes to be monitored 
• The number of concurrently logged-in users 
• High availability Yes/No (not available in version 1.3) 

The input of the licence key activates the licensed functions. An unlicensed 
RiZone Appliance has the functional scope of RiZone Light. 
 

Model No. Designation  

7992005 RiZone volume licence for 10 IP nodes 

7992006 RiZone volume licence for 25 IP nodes 
7990007 RiZone volume licence for 50 IP nodes 
7990008 RiZone volume licence for 100 IP nodes 
7990009 RiZone volume licence for 250 IP nodes 
7990012 Microsoft SCOM Management Pack 
7990001 RiZone Server Appliance 

  7990003 RiZone Server Software Appliance 
 

4.1 Querying the licence status 
The Administrator > Licence entry displays the customer number, the 
licence key, the instance number and all licensed functions. 

4.2 Functional restriction of RiZone Light 
RiZone Light supports the following components: 

• 10 IP nodes 
• 1 client Access licence 
• UPS, single-phase 
• CMC-TC, incl. LCP Standard 

4.3 Input of the licence key 
The Administration -> Licence menu can be used in the dialog to enter a 
licence key. 
If no code is entered, the user operates in RiZone Light mode. 
The RiZone licence key is entered in conjunction with the customer number 
and the instance number. Once the licence data has been entered, Check 
must be clicked to check the input. The licensed functions will be shown in 
the licence window. 

4.4 Exceeding the licensing for RiZone 
The user adds an additional device from the Discovery. No licence check is 
made when the project is created. This check is done only when the project 
is uploaded to the server. 
When the project is uploaded to the server, the following message appears 
in the message window: 
The number of project nodes exceeds the limitation. The project was 
not uploaded. 

4.5 Configuring of unsupported devices for RiZone Light 
The user adds an additional device from the Discovery. No licence check is 
made when the project is created. This check is done only when the project 
is uploaded to the server. 
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When the project is uploaded to the server, the following message appears 
in the message window: 
The project contains devices that are not compatible with RiZone Light. 
The project was not uploaded. 

4.6 Exceeding the licensing of the logged-in clients 
When a user is logged in to RiZone, a check will be made whether sufficient 
client access licences are present. If the maximum number of licences is 
reached, the following message will be issued: 
The number of concurrently used clients is exceeded. 
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5 Login mask 
The RiZone server must be registered before the first login to RiZone is 
made. The registration installs a certificate for the encrypted communication 
from the server and the GUI on the client PC. 

 

Important! 
The certificate must have been created 
once previously on the server. For 
details, see Chapter 2.3.1. 

 

5.1 Registering a RiZone server 
Prior to the registration of a RiZone server, it must be guaranteed that the 
server can be accessed from the client PC. The accessibility can be checked 
with the Ping command from the command line of the operating system. If 
the Ping command is performed successfully, the registration of the server 
can be performed. 
To register the RiZone server, the RiZone GUI is opened. If a server is 
already registered in the GUI, the server will be shown in the server selection 
box. A server is registered from the Others menu item. 
 
 
 
 
 
 

Fig. 7  Registering a RiZone server 
The login mask opens a second window that permits the registration of a 
server. Several servers can be registered. 
 
 
 
 
 
 
Fig. 8  Registering a RiZone server 
The name of the RiZone server is entered in the Host input field. If the 
RiZone server cannot be reached, a tooltip will appear when the OK button 
is clicked and an exclamation mark indicates the Host menu item. 
 
 
 
 
 
 
Fig. 9  Registering a RiZone server 
When the registration of the RiZone server has been performed successfully, 
a message window will open that informs about the download of the 
certificate. This message must be confirmed with Yes. After the confirmation, 
the login mask opens. 
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Fig. 10  Registering a RiZone server  

5.2 Login process 
The RiZone GUI is started on the client PC. The RiZone login window opens. 
The RiZone server can be selected in the selection box. If no server is 
offered for selection, a RiZone server must be registered (See Section 5.1). 
For the first login to the RiZone server, the user is preassigned with 
RiZoneAdmin. The standard password for the RiZoneAdmin is: RiZ0ne!! We 
recommend that you change the password before the first login. 

5.3 Changing the password 
The RiZone GUI is started on the client PC. The RiZone GUI login window 
opens. The RiZone server can be selected in the selection box.  
The user's password is changed by clicking the Change menu item next to 
the Password input field. A second window opens in which the old password 
and the new password (twice) must be entered.  
 
 
 
 
 
 
 

Fig. 11  Changing the password 
The password for RiZoneAdmin must be at least seven characters long and 
contain a special character and both uppercase and lowercase characters. 
Once the password has been changed successfully, the login dialog opens.  
If an unsafe password has been selected, a message text will appear in the 
window. 
 
 
 
 
 
 

Fig. 12  Changing the password 

5.4 Selecting the GUI language 
The GUI language is selected at the login to RiZone. If the GUI language 
differs from that of the operating system, all RiZone message boxes use the 
language of the operating system.  
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User starts the client 
 

 
 

Fig. 13  Selecting the GUI language 
 

6 RiZone user interface 
This chapter provides an overview of the most important subareas of the 
RiZone user interface.  
The RiZone user interface has two different modes, the admin mode and the 
view mode. You reach the admin mode only when you are logged in as user 
with administration rights. The user must be in admin mode to create new 
projects or edit existing projects. In view mode, the current RiZone project 
can be monitored only. Depending on the user rights, components can be 
controlled and device configurations changed from within RiZone. 

 
Fig. 14  RiZone user interface  
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1 Drop-down main menu 
2 Toolbar (refer to the toolbar explanation) 
3 Tabs for project trees 

Locations tab: Project tree for the location structure. The components 
are represented in accordance with their physical arrangement. 
Devices tab: Project tree of all SNMP components. The components 
are represented in accordance with their technical arrangement.  

4 View window: Variable values and graphical evaluations are shown here.
If several views are called, it is possible to switch between these using 
the tabs at the top of the View window. 

5 Properties window of the components 
The properties of the components selected in window 2 are displayed. 

6 Status window 
The current status messages appropriate for the currently selected 
action are output here. 

 
Toolbar explanation 

1.  New project (active only in admin mode) 
Creates a new local project. To activate the project, it must be 
uploaded to the server. 

2.  Open project (active only in admin mode) 
Opens a project file on a drive and loads it to the client. To activate 
the project, it must be uploaded to the server. 

3.  Save project (active only in admin mode) 
Saves the project currently open in the client to a drive. 

4.  Upload to server (active only in admin mode) 
Uploads the project currently open in the client to the server and 
activates it there immediately. Important: The project currently 
present on the server will be overwritten. 

5.  Start project (active only in admin mode) 
The client changes to the view mode and then shows the current 
and historic data collected by the server. The project used here is 
that what was most recently uploaded to the server. 

6.  Download from the server (active only in admin mode) 
Downloads the current project from the server to the client. The 
project on the server remains active. Any changes made previously 
in admin mode will be discarded. 

7.  Discover (active only in admin mode) 
Opens the discover window. 

8.  Configure project (active only in view mode) 
The client changes to admin mode. The project can be edited here 
(discover, add or remove components, create charts, etc.). 
 



7 Creating a new project 
 

EN  

7 Creating a new project 
To create a new project, the user must be logged in as RiZone administrator. 

7.1 Creating a new project 
To create a new project, first click Project > New project or click the New 

project  icon, specify a name for the project and confirm by clicking OK. 
The newly-created project now appears in the left-hand side of the RiZone 
window. 
 
For configuring, the existing infrastructure must first be created in a tree 
structure below the project name (root node). 
To do this, select the Locations tab in the left-hand subwindow. 

Then right-click the Root node  and select the Add item from the 
opened context menu. Select here the required component from the 
Location, Building, Room, Enclosure Suite and Enclosure infrastructure 
components, assign a meaningful name and a description. After clicking OK 
to confirm, the new component appears below the root node. 
Add additional components similarly until the infrastructure of your data 
centre is represented in the project tree. 
Drag & drop can be used to subsequently assign created components to 
other components. Only logical moves, however, are possible here (a room 
cannot be assigned to an enclosure). 

7.2 Entering the SNMP components in the network 
After the base project tree has been created, it must be populated with the 
components to be monitored actively. 

7.2.1 Autodiscovery of the SNMP components 
Active Rittal components in the network that support the SNMP protocol can 
be acquired using the Autodiscovery function and then added to the project 
tree. 
 

Select from the Edit > Discovery drop-down menu or click the  icon in 
the toolbar.  
The discovery window then opens. 
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Fig. 15  Discovery 

 
Parameters in the discovery window 
Discovery The Discovery checkbox activates the selected protocol for 

the discovery process. 
Start-IP RiZone begins with the search for Rittal SNMP components 

starting at this IP address. 
Stop-IP RiZone begins with the search for Rittal SNMP components 

ending at this IP address. 
SNMPRead 
Community 

Read community that contains the SNMP components 
(default public). 

SNMPWrite 
Community 

Write community that contains the SNMP components 
(default public). 

 
Once the parameters have been set correctly, click Start to start the 
automatic discovery function. 
RiZone now searches for active Rittal components in the specified address 
range. A list with the devices supported by the current release can be found 
in the Release Notes for the appropriate current version on 
www.rimatrix5.com (Service&Support > Downloads > Software area).  
 

http://www.rimatrix5.de/
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found under Devices. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig. 16  Discovery with discovered components 

 
 
A click on the plus sign in front of a component shows additional 
subcomponents (e.g. sensors). 
From the device list, the components in accordance with their arrangement 
in the data centre can be moved with drag & drop into the Locations project 
tree. 
Several components can be selected and dragged with the Ctrl key and 
clicking. The order of clicking determines the order of the display in the tree 
after dragging. 
Components already assigned to a tree are marked light-blue in the 
discovery list. 
During the move to the locations tree, the device also appears 
automatically in the devices tree, but not conversely. A device cannot be 
moved subsequently from the devices tree to the locations tree. This must 
be done by performing a new discovery of the device and then moving to the 
locations tree. 
Components in the locations tree can be moved subsequently with drag & 
drop to a different location. 
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Warning! 
All components must be selected individually. 
For example, the selection of a PU does not 
automatically include the selection of the 
associated connected components. 

 
The list of the discovered devices can be deleted by clicking the Reset 
button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 17  Project tree with Rittal components 

 
Fig. 17 shows a project tree for which the discovered components have 
already been added. 
 
Basic configuring is completed once all infrastructure components have been 
acquired and the active SNMP components added. 
The project should now be saved with Project > Save project or by clicking 

the  icon. 
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Note! 
The project can be saved only for the 
selected project tree. 
Before saving a project, a component 
of the devices tree or locations tree 
must be selected. 

 

7.3 Deleting components 
Right-click the component to be deleted and select the Delete item in the 
context menu. 
The component will be deleted immediately from the view. 
If a device is deleted in the Locations tree, it is still present in the project 
and in the Devices tree. If a device is deleted in the Devices tree, it is also 
deleted from the locations tree and removed completely from the project. 
If a variable used in a chart is deleted, this variable will be deleted from the 
chart. A workflow and a calculation will be deactivated when a variable is 
deleted. Both messages will be displayed in the GUI message window. 

7.4 Starting a project 
Before a project can be started, it must first be uploaded to the server. This 

is done from the Project > Upload to server main menu or with the  
icon. The prompt whether the project should be uploaded must be 
confirmed. The upload to the server has completed once the "Validation 
completed, the project has been uploaded to the project folder" message 
appears in the message list. 
The created RiZone project will now be performed on the server and so all 
active components also fetched using SNMP and any created workflows 
performed. 
 

Project > Start project or  is used to switch the RiZone client to view 
mode. The live data arriving at the server can be displayed in view mode. In 
this mode, the user also has access to the historical values that have been 
collected since the start of the project. These values, for example, can be 
displayed using charts. 
All project start messages are listed in the message list. The prompt whether 
the project should be started must be confirmed. 

7.5 Editing a project 
If necessary, an existing project can be changed. To edit the project, the 
user must be in GUI admin mode. The project can be downloaded from the 
RiZone server or opened locally from the hard disk. The project is 
downloaded from the Project > Download from server main menu or with 

the  icon. The project can now be edited. 
The original project will continue to run until the modified project has been 
uploaded to the server. The editing of the project does not affect any other 
users. 
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7.6 Displaying values and variables 
Once the project has been started, RiZone can be used to easily display all 
available values that the individual components supply. 
CMC-TC sensor example: 

• Right-click the required sensor (locations tree or devices tree) in the 
left-hand window. 

• Select Variables in the context menu. 
• The sensor variables will now be listed in the View window (right-

hand side). All acquired values (in Fig. 18, the temperature) and the 
settings (SetHigh, SetLow, SetWarn) will be output. 

 
 
 
 
 

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 18  Output values in the started project 
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fetched, a list with all sensors, PSM busbars, etc. assigned to the component 
opens in the View window. A click on the arrow in front of a sensor then 
shows its values. 
 

 
Fig. 19  Variables of an enclosure (Rack1) 

 
The Monitoring, Cooling, Security, Availability and Power status variables 
describe the status of the associated groups of this infrastructure 
component.  
TotalStatus provides the overall status of the infrastructure component over 
all groups. 

7.7 Displaying values from the website 
An alternative means of displaying sensor values involves calling the website 
of the components. 
A right-click on the component and the selection of Open website opens a 
browser window in which the website of the component (e.g. CMC-TC 
Processing Unit II) is called.  
 
 

22 RiZone 

 



EN

7 Creating a new project 
 

RiZone  23 

 

 

 

Note! 
The following functions are available 
only when you are in admin mode. 
Log in with a user who is member of 
the RiZone administrators group. 

 

Note! 
Changes take effect only after the 
project is uploaded. 
Save the project and upload it to the 
server. 

 

7.8 Creating a new variable 
Variables can be created in RiZone. These variables are assigned to an 
infrastructure component (e.g. room, enclosure, etc.). 
A new variable is created by right-clicking in the variable view and selecting 
the New variable [location] item in the menu. 
 
Input possibilities for creating a new variable 
Name Name of the variable 
Description Description of the variable 
Publish If set, the variable will be passed to the Messaging 

Service. 
Interval Specifies the calculation cycle (in seconds). Off 

means that the variable will be calculated once after 
the project is uploaded. 

Physical 
measurement 
quantity 

Specifies the measurement quantity of the variable 

Unit Specifies the unit of the variable 
Display factor Display factor of the variable 
Display format ,n:m where n specifies the number of digits before 

the decimal point and m the number of digits after the 
decimal point. Example: ,5:0.00 -> five digits before 
the decimal point and two digits after the decimal 
point. 

Group Selection of the group of the variable. 
The selection of the group affects the group status 
variables of the component to which the variable in 
the project is assigned. If the variable is assigned to a 
group and changes its status, the group status 
variable of the higher-level infrastructure component 
also changes its status to that of the variable 
(Exception: Another variable has already raised the 
status of the group status variable to a critical status). 

 

7.9 Editing a variable 
Variables can be edited in RiZone. A variable is edited by being right-clicked 
and the Edit variable item selected in the menu. 
The variable name and the physical measurement quantity cannot be 
changed. 
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7.10 Deleting a variable 
Variables you created in RiZone can be deleted. A variable is deleted by 
being right-clicked and the Delete variable item selected in the menu. 

 

Note! 
Only those variables you created 
yourself can be deleted. 

 

7.11 Calculating a variable 
RiZone can calculate variables. The four basic arithmetic operations, 
brackets and Boolean algebra can be used as mathematical operators. Self-
created variables can be used to link variable values mathematically, for 
example, those supplied by sensors. The self-created variables can then be 
used further within RiZone, for example, for display in charts or in workflows. 

7.11.1 Selecting a variable 
Only self-created variables can be calculated. To select the variable, the 
variable view of a component must be opened in admin mode. A right-click 
opens the context menu of the variable and selects the Calculate variable 
entry. 
The Calculate <variable name> menu opens. 

7.11.2 Selection of the component for calculating the variable 
The component is selected using drag & drop. The component that contains 
the variable required for the calculation is selected in the project tree. Drag 
the component to the Component field in the variable calculation window; 
you then have access to all available values of the component. 
 

 

Note! 
Only those components that contain 
numeric variables can be selected. 

 

7.11.3 Selection of the variable 
Once the component has been selected, all variables will be displayed in the 
window. These variables are selected individually and with the Down arrow 
button transferred to the variable list. Only numeric variables can be 
selected. 

7.11.4 Transfer of the variables to the formula field 
A variable is transferred to the formula field by being marked with the left 
mouse button and transferred to the formula field by copying the variable 
with Ctrl-C and pasting the variable with Ctrl-V. 

7.11.5 Creating the formula 
The mathematical expression can be created in the formula window. The 
four basic arithmetic operations, Boolean algebra and the setting of brackets 
are available. 

7.11.6 Checking the calculation 
RiZone checks the formula for mathematical correctness. If the formula is 
correct, it can be saved. The check is initiated by clicking the Validate 
button. 
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7.11.7 Saving the formula 
If the formula has been validated successfully, it can be saved. To start the 
calculation, the project must be loaded to the server. 
The formula is saved by clicking the Save button. 

8 Views 
The views can be used to create graphical representations of your complete 
infrastructure components.  
Views can be created for each component in the locations tree. A 
differentiation between the lateral view and the plan view is made for the 
representation of the views. Whereas the location, building and room 
component types have a plan view, the enclosure suite and the enclosure 
have a lateral view. 
Customised graphics (e.g. the floor plan of a computing room) can be 
created for plan views. The graphic can be manually overlaid with active 
buttons that indicate the status of the components. For the lateral views, the 
corresponding graphics of the enclosures and components are already 
present in RiZone and only need to be assigned appropriately to the project. 
The views are configured in admin mode. 
 

 

Note! 
Status variables must be assigned to a 
group so they can be evaluated 
coloured in the view. 

 

8.1 Creating a new view 
The selection of the Views menu item creates the view for a component. 
Only the view for one component can be edited concurrently. 
The view opens in edit mode in the main view of the GUI.  
A view is created by right-clicking the component icon. A context menu now 
opens and the View function can be selected. Alternatively, moving the 
mouse over the component displays five icons. The second icon from the left 

 opens a new view. 
The new view must first be scaled before it is created. This function can be 
used to create scaled views on the component level because all RiZone 
components exist as SI units. 
Scaling is made in mm and can be given a scale. 

8.2 Editing a view 
A previously opened and stored view is opened for editing by calling the Edit 
view function in the View menu. 
The opened view has a pink frame that indicates the editing mode. 

8.3 Loading a background picture 
A right-click in the view window opens the dialog for loading a background 
picture. Call Load background to open the Open file window from which a 
.jpg format file can be selected. The file size of the picture may not exceed 
1 MB. 
The background picture will be created. 

8.4 Assigning a component to a drawing 
A component is assigned to a drawing by dragging in the drawing. The 
mouse can be used to place the component anywhere in the view. 
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A view is saved by calling the Save view function in the Views menu. 

8.6 Operating the views editor 
The views editor provides the following functions: 

 Zoom 

 Rotate 

 Draw polygon 

 Undo 

 Step forwards 

8.6.1 Zoom 
The zoom function can be performed by clicking the Magnifying glass icon 
or by pressing the Ctrl key and using the mouse wheel. 
 
Selecting the magnifying glass activates the zoom function. It is now 
possible to zoom a rectangle from the view. A subsequent right-click restores 
the original size. 
 
A view can be zoomed by pressing the Ctrl key and the mouse wheel. The 
view must be clicked to perform this function. The zoom function is then 
available. Pressing the right mouse button restores the original size. When 
the mouse wheel is turned forwards, zooming is made into the view; when 
the mouse wheel is turned backwards, zooming is made from the view. 

8.6.2 Rotate 
A component is rotated in a view always at the centre of the selected 

component. The Rotate icon is a sector of a circle with arrow . The 
component is selected in the view and then the Rotate icon selected. Once 
the rotate function has been selected, the component can be rotated. 

8.6.3 Polygons 
The RiZone editor can be used to draw a polygon and then assign this 
polygon to a RiZone infrastructure component. The polygon in the drawing 
uses the colours green, yellow and red to indicate the three OK, warning and 
alarm states of the component, respectively. 
 

 

Note! 
Status variables must be assigned to a 
group so they can be evaluated 
coloured in the view. 

 
The Polygon icon is used to activate the drawing of a polygon. A left-click 
can now be used to add a corner of the polygon. A double-click closes the 
polygon. 
 
A drawn polygon can be edited in drawing mode. Individual corners can be 
moved or corners added (arrow cursor and Ctlr right-click on a line) or 
deleted (arrow cursor and Ctrl right-click). 
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A polygon can be assigned to a component in the component tree. Please 
proceed as follows: 

1. Mark the component in the locations tree. 
2. Keep the Alt key pressed. 
3. Now drag & drop the marked component to the required polygon. 

If the action completed successfully, the polygon colour changes to green. 

8.6.4 Undo 
The Undo function can be used to undo the creation steps. 

8.6.5 Restore 
The Restore function undoes the undo function. 

8.6.6 Multiple selection 
A multiple selection of components is possible by drawing a frame around 
the components to be selected. The selected components are coloured. 

8.6.7 "Go to" and "Open website" functions 
View mode: If a view is open, a right-click on the individual components (e.g. 
PSM busbar) calls a context menu. Depending on the component and the 
configuring, none or one of the Go to or Open website options appears 
here. 
 
Go to 
The view of the clicked infrastructure components opens. This is possible 
only when the view was created previously in admin mode. 
Example: In the multiple-enclosure view, a right-click is made on a specific 
enclosure and Go to selected. The enclosure view (provided created) of the 
selected enclosure now opens. 
 
Open website 
A right-click on a sensor connected to a Processing Unit II or an LCP opens 
the context menu with the Open website option. The selection of the Open 
website item opens in the standard browser the website of the Processing 
Unit II that belongs to the sensor. 

8.6.8 View list 
The view list of a component can be called from its context menu (right 
mouse key). 
In admin mode, existing views can be edited or new views created in the 
view list. 
In view mode, a selection from the existing views can be made. A double-
click on the view opens it. 
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9 Charts in RiZone 
The chart function can be used to display measured values graphically in 
RiZone. It is possible here to display several values in a diagram. 
Charts must be grouped in admin mode. When the project is started, the 
created charts can be called and then show the current and historic acquired 
values. 
The chart list shows all charts assigned to the infrastructure component. The 
context menu (right-click), new charts can be created or existing charts 
renamed or deleted. 
 

9.1 Creating charts 
Charts are linked to a component (sensor, PU, LCP, etc.) or an infrastructure 
component (location, building, room, enclosure suite, enclosure) during their 
creation. For a started project, these charts can then be called using the 
appropriate (infrastructure) components. 
 

Fig. 20  Creating a chart 

 
To create a new chart, right-click the component with which the chart is 
linked and select Charts or Chart list. The chart list shows all charts 
assigned to the infrastructure component. The required chart can be 
selected with a double-click from this list. 
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The chart configuration now opens in the View window.  

 
Fig. 21  Chart configuration 

Legend 
1 Add/remove a new chart 
2 Add/remove a diagram within a chart 
3 Add/remove a variable to/from a diagram 
 
Input possibilities in the chart configuration 

Name Name of the chart 
Description Description of the chart 
  
Name Diagram name 
Diagram type Representation of the values in the diagram as 

line, pie or bar chart (Gantt) 
Colour Measuring curve colour. Clicking the colour opens 

a colour selection palette that can be used to 
specify the colour for this measured value.  

Description Description of the measured value 
Axis caption Title of the Y-axis for this measured value 
Variable The measured value to be displayed is selected 

here. 
Drag & drop a component from the project tree to 
the Variable field. The drop-down menu can then 
be used to select all available measured values of 
the selected component. This value will then be 
displayed later in the diagram.  
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Min-Y Minimum value of the Y-axis. It should be adapted 

to the expected minimum value of the selected 
measured value. 

Max-Y Maximum value of the Y-axis. It should be adapted 
to the expected maximum value of the selected 
measured value. If Min and Max = 0 are specified, 
an automatic scaling will be performed. 

Unit Unit of the acquired measured value 
AxisID Selection of the associated axis. If several units 

are used, each unit has its own axis. 

Format 1st field: Minimum number of digits before the 
decimal point (permits the alignment of the 
measured values under each other in the diagram 
legend) 
2nd field: Digits after the decimal point 

Factor Scaling factor for the measurement curve and 
legend. Can be used, for example, to output 
energy values in kW rather than watts. 

Chart preview Displays a preview of the configured chart. 
 
The + and – buttons can be used to add or remove values to/from the chart. 
Click + to add a new configuration row. These values can originate from 
different components. This allows the very flexible creation of individual 
charts. 
A click on – removes the marked measured value row from the chart 
configuration. 
 
The drop-down main menu can be used to discard any changes that have 
been made. To do this, select Charts > Reset chart. RiZone contains 
standard charts for some components (LCPs). They can be restored at any 
time with Charts > Load standard charts. 
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Fig. 22  Chart configuration example 

 
Fig. 22 shows an example configuration for an LCP chart that shows the 
LCP temperature (green), the high temperature warning threshold of the 
LCP (red), the low temperature warning threshold of the LCP (blue) and the 
warning temperature warning threshold of the LCP (orange). 
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9.2 Displaying a chart 
Once the chart has been configured, the chart together with the complete 

project can be loaded to the server (Project > Upload to server or ). 
The chart can also be fetched when the project is performed (Project > 

Start project or ). 
 

Fig. 23  Fetching a chart 

 
To do this, right-click in the project tree the (infrastructure) components to 
which the chart was linked for the configuration and select Charts or Chart 
list. If Chart list was clicked, the chart still to be edited must now be 
selected. 
 
The chart opens in the View window and the values supplied by the 
components to RiZone are shown. 
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Fig. 24  Chart representation for the started project  

 
The elements in the uppermost line of the chart window can be used to set 
the representation interval of the chart. 
1 Interval The time interval of the chart display can 

be selected here (15 minutes, hourly, 
daily, etc.). 

2 A Updates and sets the cursor to the 
current value in the chart. 

3 Time The date and the time when the chart 
display should begin can be specified 
directly here. 

4 Chart selection If several charts were created for the 
component, it is possible to switch 
between the individual charts here. 

 
 

10 Workflows  

10.1 Operation of the workflows in RiZone 
The workflows in RiZone are used for the automatic processing of 
conditional actions. The actions involve the setting of values using SNMP, 
the sending of e-mails and the parameterised call of external programs. The 
values of the monitored devices collected by RiZone or the variables 
calculated by RiZone can be used for the conditions that determine the 
execution of an action. Once a workflow together with a project is uploaded 
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server. 

10.2 Creating a new workflow 
A workflow is always assigned to an infrastructure component (room, 
enclosure suite, etc.). Each workflow, however, always has access to all 
sensor values of the project and not just to the values assigned to "its" 
infrastructure component. 
To create a new workflow, right-click the infrastructure component and select 
Workflow list in the context menu. 
The overview window for all workflows of the component (workflow list) now 
opens. A right-click on New in the workflow list creates a new workflow. 
Enter a name for the workflow and click OK to confirm. The new workflow 
will now be shown in the list and can be edited. 

10.3 Deleting a workflow 
To delete an existing workflow, right-click the infrastructure component and 
select Workflow list in the context menu. 
The overview window for all workflows of the component and the logically 
subordinate components now opens. 
A right-click on the workflow to be deleted opens the associated context 
menu. Select Delete to delete the workflow. 
Click Yes to confirm the delete action. 
The workflow will now be deleted. To also delete the workflow on the server, 
the updated project must first be uploaded to the server (see Upload 
project). 

10.4 Editing a workflow 
To edit a workflow, right-click the infrastructure component and select 
Workflow list in the context menu.  
Right-click to select the workflow to be edited. The associated context menu 
opens. Select Open. 
The graphical workflow editor now opens. 
The pink frame of the workflow editor window indicates the edit mode. The 
editing is completed with the Workflow > Save workflow drop-down menu 
(the pink frame vanishes). To return to the edit mode for an open workflow, 
select Workflow > Edit workflow. 
The workflow can now be formed using workflow modules (see Workflow 
modules section). To create a workflow, click the required modules in the 
module bar which then appear immediately on the workflow work surface. 
After the first click on the icon, it appears on the work surface, brought to the 
correct position and released with a left-click. 
A double-click on an icon opens the associated properties menu. The 
properties of the module can then be configured (for details, refer to the 
Workflow modules section). 
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10.5 Structure of a workflow 
A workflow consists of various modules (refer to Workflow modules section) 
connected with each other using arrows (directed edges). The arrow 
direction also specifies the flow direction through the workflow. 
During the creation, ensure that: 

1. Just one start symbol exists. 
2. At least one end symbol exists. 
3. All modules have just one successor (= outgoing arrow). The Event 

Gateway and Data Gateway are exceptions. These elements can 
have several successors. 

4. All symbols are connected with each other using arrows. 
5. At least one action must be defined. 

A workflow will be validated for correct syntax before it is saved. The 
workflow must be corrected if the validation fails.  
The error description for the errors on the workflow will be output in the 
message list. 
Otherwise the workflow will only be saved and not switched active when 
uploaded to the server.  
 

 

Note! 
During the RiZone operation, it is not 
possible to determine whether a 
workflow is active.  
Check carefully the validation of the 
workflow. 

 

10.6 Workflow modules 
This section describes the individual workflow modules and their 
configuration capabilities. 

10.6.1 Start event 
 

 

 

 Fig. 26  Start event 

The Start event indicates the starting point of each workflow. It must be 
present just once in each workflow. The properties menu contains only the 
name and the unique symbol ID (UID). 

10.6.2 Stop event 

 
 Fig. 27  Stop event 

The Stop event terminates a workflow. At least one Stop event must exist 
for each workflow. Several Stop events are possible in a workflow. 
The properties menu contains only the name and the unique symbol ID 
(UID). 
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10.6.3 Condition event 

 
 Fig. 28  Condition event 

The Condition event stops the workflow at this point until the set condition 
(e.g. an alarm of a specific sensor) occurs. 
 

 
 Fig. 29  Condition event properties 

A double-click on the symbol opens the properties window of the Condition 
event. To configure the condition, proceed as follows: 

1. Select the Operator in the lower window. The Equal operator is 
selected in the figure. Possible operators are: Equal, Unequal, 
Above, Below, AboveOrEqual, BelowOrEqual, And, Or. 

2. Now select the first operand.  
3. The Nature menu can be used here to select whether a constant or 

variable is involved. If you select a variable, a sensor that supplies 
the required sensor value must then be selected. To do this, left-
click the required component from the locations or devices view and 
move with drag & drop to the free menu field with the designation 
Variable.  

4. You can then select from the selection menu a variable from the list 
of all variables supplied by the component. 
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5. If you want to enter a constant, select for Nature the Constant 
option and enter the required value for Value. 

6. Select this for the second operand and repeat steps 3 to 5 as for the 
first operand. 

 

 

Note! 
Nested operations are possible when 
"and" or "or" is selected as operator. 

 
Click Apply to accept the changes or Reset to reset all settings. The window 
can be closed by clicking the "Close window" icon at the top right. 

10.6.4 Timer event 

 
 Fig. 30  Timer event 

The Timer event stops the workflow at this point until the set time has 
expired. 
A double-click on the icon opens the properties window of the Timer event. 
The time unit (seconds, minutes, hours, days) and the time value can be set 
here. 
 
Example: A delay of 15 seconds should be set 
Unit = seconds 
Time = 15 

10.6.5 Send Email  

 
 Fig. 31  Send Email event 

The Send Email event can be used within a workflow to send an e-mail. The 
e-mail will be sent when the workflow reaches the Send Email event.  
A double-click on the icon opens the properties window of the Send Email 
event. 
The following parameters must be configured here: 

• toAddress: Target address 
• Subject: Subject line  
• Text: E-mail text 
• FromAddress: Sender address 
• SmtpServer: IP address of the SMTP server 
• SmtpUser: If the authentication is successful, the user name must 

be entered here 
• SmtpPassword: If the authentication is required, the password must 

be entered here 
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10.6.6 Execute Program 

 
 Fig. 32  Execute Program event 

The Execute Program event can be used within a workflow to start an 
external program on the server. The program will be started when the 
workflow reaches the Execute Program event. 
A double-click on the icon opens the properties window of the Execute 
Program event. 
The following parameters can be configured here: 
 

• Program: The program name, incl. path. Important: The program 
must be located on the RiZone server rather than on the client on 
which the GUI runs. 

• Arguments: Call parameters for the program to be started. The 
values and the syntax depend on the program to be started. 

 

 

Note! 
The program will be executed on the 
RiZone server under the RizoneService 
user. This means the graphical user 
interface for the executed program is 
not visible. 

 

10.6.7 Set Value 

 
 Fig. 33  Set Value event 

The Set Value event can be used to set a value within a workflow using 
SNMP. This requires that the actor has already been integrated in the 
RiZone project using the Discovery function. The value will be set when the 
workflow reaches the Set Value event. 
A double-click on the icon opens the properties window of the Set Value 
event. 
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   Fig. 34  Properties of the Set Value event 

 
To configure the setting of a value, proceed as follows: 

1. Left-click the required component from the locations or devices view 
and move with drag & drop to the free menu field with the 
designation Variable.  
 

Note! 
If the Variable field remains empty after 
a device has been added, this device 
does not have any variables that can 
be set.  

 
2. You can then select from the selection menu a settable variable from 

the list of all variables supplied by the component. 
3. Now enter for Value the value to be set on the actor or select one of 

the states that may be specified. 
Click Apply to accept the changes or Reset to reset all settings. Click OK to 
close the window. Cancel terminates the configuration of the workflow. 
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10.6.8 Event Gateway 

 
 Fig. 35  Event Gateway 

The Event Gateway is a branch on two or more Condition events. 
Important note: The direct successors of an Event Gateway can be only 
Condition events or Timer events (refer to the Event Gateway example 
figure). 
 

 
 Fig. 36  Event Gateway example 

 
If, during the processing, the workflow reaches the Event Gateway, the 
workflow will continue at that Condition event whose condition is satisfied 
(true) first. 
 

 

Note! 
This condition is executed just once. 

The condition will be executed again 
only when it reoccurs. 

  

 

Note! 
If no condition is satisfied, a wait will 
be made at the Event Gateway. 
The wait at the Event Gateway 
continues until one of the conditions is 
satisfied. 
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10.6.9 Data Gateway 

 
 Fig. 37  Data Gateway 

The Data Gateway is a branch on two or more events. 
The direct successors of a Data Gateway can be all modules except for the 
Start symbol. 
The conditions that determine which path the workflow follows are linked at 
the outgoing edges for the Data Gateway. 
To specify a condition, the properties window of the edge must first be 
opened with a double-click on the edge.  
 

 
 Fig. 38  Properties of an outgoing Data Gateway edge 

The condition can now be specified as follows: 
 

1. Select the Operator in the lower window. The AboveOrEqual 
operator is selected in figure 38. Possible operators are: Equal, 
Unequal, Above, Below, AboveOrEqual, BelowOrEqual, And, 
Or. 

2. Now select the first operator.  
3. The Nature menu can be used here to select whether a constant or 

variable is involved. If you select a variable, a component that 
supplies the required sensor value must then be selected. To do 
this, left-click the required component from the locations or devices 
view and move with drag & drop to the free menu field with the 
designation Variable.  

4. You can then select from the selection menu a value from the list of 
all values supplied by the sensor. 
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option and enter the required value for Value or select one of the 
states that may have been specified. 

6. Select this for the second operator and repeat steps 3 to 5 as for the 
first operator. 

7. Click Apply to accept the settings. 
 
The condition for this edge is now configured. 
 

 
 Fig. 39  Default Gateway example 

 

Important! 

One edge must be defined as default 
edge. To do this, the value for Type in 
the properties must be changed to 
default.  
If during processing the workflow 
reaches the Data Gateway and no 
condition of any of the outgoing edges 
is satisfied (=true), the workflow will be 
continued at the default edge. 
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11 Maintenance mode 
The maintenance mode indicates that the configuration of a device has 
changed. In this state, the device data can no longer be evaluated in 
RiZone. The maintenance mode is indicated by a spanner in front of the 
devices icon.  
 

 
  
All variables of the affected device change their state: 
Quality = "Bad" 
Quality Detail = "COMPONENT_MAINTENANCE_MODE" 
The maintenance mode causes the calculations of the Calculation Engine to 
be supplied automatically with the Quality Bad. No events will be initiated in 
the Workflow Engine. 
 
There are several possibilities why a device has changed to maintenance 
mode. There are two ways of leaving the maintenance mode.  
The device changes its configuration back to the original state. In this case, 
the maintenance mode will be deactivated automatically. 
The device will be rescanned in the configuration mode and with pressed Alt 
key moved to the affected device in the project tree. The current settings are 
now accepted as original. 
  

11.1 Reasons for a maintenance mode 

11.1.1 Change of the temperature unit 
For Rittal CMC devices, the temperature unit can be changed between °C 
and °F. This also changes the values transported via the SNMP interface. 
This situation means the calculated values and limit value tests in a workflow 
are incorrect and the maintenance mode will be activated. If the device 
changes its temperature unit back to the configured state, the maintenance 
mode will be revoked automatically (if the change is made from the website, 
this can take as long as five minutes). Incorrect calculations and workflows 
cannot be excluded during this time. 
The maintenance mode is activated only for those devices that supply a 
temperature value. You can recognise this by them having a "Temperature 
Unit" entry in the properties window. This shows the state present during the 
Discovery. 
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LCP 
LCP Extend 
LCP Inline 
LCP Inline EC 
LCP Plus 
LCP Plus EC 
LCP Smart 
Temperature sensor 
Temperature sensor WL 
The Climate Unit does not have this field because the temperature sensor 
exists as an independent device. 
  

11.1.2 Change of the hardware configuration 
The possible changes are listed in the properties of the LCPs.  

  
These properties are assigned to the device during the Discovery. If these 
no longer match those of the device, a switch is made to maintenance mode. 
The maintenance mode will be exited when the old state is restored. If the 
device with the changes is to be accepted, it must be deleted from the 
project and a new discovery performed. Alternatively, it can be moved with 
pressed Alt key to the existing component and so updated.  
  
The following devices have these fields: 

LCP Inline / Water sensor / Flowmeter / Control valve 
LCP Inline EC / Water sensor / Flowmeter / Control valve 
LCP Plus / Water sensor / Flowmeter / Control valve 
LCP Plus EC / Water sensor / Flowmeter / Control valve 
LCP Smart / Water sensor / Flowmeter / Control valve / Condensation 

pump 
LCP / Fan module 1 / Fan module 2 / Fan module 3 / Water 

module  
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12 Message list 
RiZone has a message list that contains all messages of the RiZone server. 
The messages have various categories, owners and states. Each message 
has a unique timestamp and owner. The message description explains the 
message. Moving the mouse over the message displays the description of 
the message as tooltip. 
The message list differentiates between current messages and finalised 
messages. Closed messages are current messages whose status has 
been set manually to Terminate. To set the Terminate status, the message 
must be opened with a double-click. The status then can be changed from 
the drop-down field. The time interval for which messages are displayed can 
be restricted. The restrictions are: 
All, 1 hour, 1 day, 1 week. 
All messages for specific categories can be filtered. The categories are: 
Errors, Warnings, Information and OK. 
The filtering applies to the displayed messages rather than all messages in 
the database. 
The arrow keys can be used to navigate through the message list. A right-
click opens the context menu. A double-click opens the properties window 
of the message. 
The individual columns can be sorted in ascending and descending 
sequence. The sorting applies to the displayed messages rather than all 
messages in the database. 

12.1 Process 
Process assigns the message. The following processes are differentiated: 

12.1.1 Monitoring 
The messages grouped in the Monitoring process apply to the active area of 
RiZone. 

12.1.2 System 
The messages grouped in the System process are system messages.  

12.1.3 Workflow 
The messages of the Workflow process are those messages issued while 
uploading a project when one or more workflows were created in a project. 

12.1.4 Calculation 
The messages of the Calculation process are those messages issued while 
uploading a project when one or more calculations were created in a project. 

12.1.5 Discovery 
The messages of the Discovery process provide information about the 
devices found during the discovery process. If RiZone does not support a 
firmware, an error message will be issued during the Discovery process. 

12.2 Owner 
The owner of a message is the component ID for RiZone. This can be a 
device, a workflow or a calculation. 

12.3 Status 
The status of a message indicates the processing status of a message. 
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12.3.1 None 
The None status specifies that the message has not yet been accepted by 
any user in RiZone. The message is not yet processed. 

12.3.2 Commit 
The Commit status specifies that the message has been accepted by a user 
in RiZone. The message is not yet processed. 

12.3.3 Work On 
The Work On status specifies that the message has been accepted by a 
user in RiZone. The message is being processed. 

12.3.4 Terminate 
The Terminate status specifies that the message has been accepted by a 
user in RiZone. The message is completed. 
Messages with the Terminate status can be viewed only from the Finalised 
messages tab.  

12.4 Properties 
A double-click on a message opens the properties window. The detailed 
message is displayed in the properties window. It is possible to change the 
status and add a comment to the message. The user who accepted the 
message is logged. 
A history of the messages is saved. 
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13 Report 
RiZone provides the capability to generate a report for the variables 
associated with a node. This report can be executed cyclically and 
downloaded from the server to the client PC. The access control for a report 
is controlled in the user administration. 

13.1 Creating a report 
A report can be created for any component of the RiZone project. The 
Report function in admin mode opens the configuration window in the GUI. 
The New function creates a new report. 
 

Fig. 39b  Creating a report 

13.1.1 Selecting variables 
The variables are selected with a mouse click in the window. Ctrl and 
mouse click are used to select more than one item. Shift and click are 
used to select a group of variables. The marked variables have a blue 
background. A click on the >> double-arrow transfers the variables to the 
selection window. The selection of the variable and the click on the << 
double-arrow deselects the variable. 

13.1.2 Name/description 
The name of a report is a mandatory field and preassigned. Only digits, 
alphabetic characters and the underscore can be used for a name. Accented 
characters are not supported. The name of a report may not begin with a 
digit. The maximum length of the name is 50 characters. 
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13.1.3 Cycle 
The regular execution of the report is configured in the cycle selection 
window. Never specifies that no report will be created. 

13.1.4 Saving a report 
A report is saved by selecting the Reports tab in the menu and then clicking 
Save. The report will be saved under the selected node. The changes take 
effect on the RiZone server only when the project has once again been 
uploaded to the server. 

13.2 Deleting a report 
A report can have been created at any node of the RiZone project. The 
Report function in admin mode opens the configuration window in the GUI. 
A list of the reports present for the node is displayed. A click on Delete 
deletes the associated report. Respond with Shift and click to the prompt. 

13.3 Downloading a report 
A report can be downloaded in the view mode of the GUI. The logged-in 
user must have the appropriate authorisations. The report has CSV format. 
The reports are saved in the ~\My Documents\RiZone\Reports directory. 
The report is downloaded by selecting the appropriate report and then 
selecting the Synchronise function. The Reports > Synchronise all option 
in the drop-down menu downloads all versions of the report.  
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14 User administration 
The RiZone user administration is based on the user administration of the 
RiZone Appliance operating system. The membership of the RiZone 
Appliance in the directory service is used to integrate the user administration 
in a directory service.  

14.1 Creating a user with the GUI 
A new RiZone user is created from the Administration > User 
administration > Users > Create user menu. The user is created as local 
user on the RiZone Appliance. The user name must consist of at least five 
characters and the password requires a minimum length of seven 
characters, including one special character. The assignment of the e-mail 
address must be unique: An e-mail address can only be entered for one 
user. All fields are mandatory for creating a user. The activation of the 
Enable user? checkbox activates the user. 
 

 

Note! 
A user must be activated in order to 
log in to the RiZone server. 
Activate the user during the creation. 

 

14.2 Changing a user account 
A user account is changed using the Administration > User administration 
> Users menu. Select the user with a double-click. 
The e-mail address and the comment for the user can be changed in the 
Change details menu item.  
The Change password menu item is used to change the password. 
The Administer roles menu is used to assign the user to one or several 
roles. 
The Delete user account menu item is used to delete the selected user. 
The Deactivate user account function is used to deactivate the user. The 
user can then no longer log in to RiZone. All user settings, however, are 
retained. 
The Activate user account function is used to activate the user. 
Administer other user accounts returns to the user selection. 

14.3 Creating a role with the GUI 
A new RiZone role is created from the Administration > User 
administration > Roles > Create new role menu. The role is created as 
local group on the RiZone Appliance. The group name must begin with 
RiZone. 

14.4 Assigning a user to a role 
The Change user account > Administer roles menu is used to assign the 
user to one or more roles. 
This is also possible by selecting the appropriate role and assigning the user 
to the role in the Roles menu. 

14.5 Removing a user from a role 
The Change user account > Administer roles menu is used to remove the 
user from a role. 
This is also possible by selecting the appropriate role in the Roles menu and 
removing the user from the role. 
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The Delete user account menu item is used to delete the selected user. 

14.7 Deleting a role with the GUI 
To delete a role, proceed as follows: 

• Select the Role tab 
• Double-click the role to be deleted 
• Click Delete role 
• Confirm the prompt 

The role will now be deleted. 

14.8 Configuring RiZone in a directory service 
RiZone is integrated in a directory service by the membership of groups of 
the directory service in the local groups of the RiZone server that were 
created as role with the RiZone GUI. 
 

15 Assigning rights for RiZone components 
Rights are assigned in a project at the component level in the project tree. 
The component rights are assigned to a RiZone role. This role is assigned to 
a user group of the operating system. Rights can be assigned in the 
locations tree and the devices tree. 

15.1 The rights concept for RiZone 
RiZone has seven different authorisations. These authorisations can be 
used for just one component or can be inherited. The inheritance permits all 
subordinate components of the selected reference tree to be given the same 
rights.  

15.2 RiZone rights 

15.2.1 Read 
The read right permits read access to the component. No changes can be 
made to the component. 

15.2.2 Setting 
The setting right permits the change of threshold values. 

15.2.3 Configuration 
The configuration right permits the change of a component. This permits 
the change of the component name or the change of the SNMP 
configuration. Specific LCP settings are also assigned to the "Configuration" 
group (some parameters from LCP Standard and Extend). 

15.2.4 Execute 
The execute right permits the switching of the outputs of a device that has a 
switching function. 

15.2.5 Charts 
The charts right permits the display of a chart. The chart must be created by 
an administrator. 
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15.2.6 Workflows 
The workflows right permits the display of a workflow. The workflow must 
be created by an administrator. 

15.2.7 Reports 
The reports right permits the download of a report. The report must be 
created by an administrator. 

15.3 Changing an authorisation in the object tree 
The rights are assigned for a component in the properties window. The 
properties window is opened with a right-click on the component icon and 
the selection of properties. The properties window opens in the GUI main 
window. The selection of the Rights tab opens the rights administration. 
The Reference tree drop-down menu is used to select in which project tree 
the rights assignment is made. The Subordinate components ... checkbox 
permits the inheritance of rights below the component. 
It is possible to assign a role to each individual right. Multiple selection is 
possible. 
The changes take effect only after the upload of the project. 
 

16 Searching for variables 
RiZone provides the capability to search for variables. It must be selected 
under which component the variable should be searched. After the selection 
of the component in the location or device tree, all available variables will be 
displayed in the variable view. The search for a variable can now be made in 
the Variable window. The use of * wildcards is possible. 
 

17 Relocating a tab as a single window 
When several monitors are used, it can be desirable to relocate the 
individual tabs of the RiZone GUI to another monitor. This is done with a 
click on the Relocate tab icon. 
This function is possible only in view mode. 
 

 
 
If the relocated window is closed, it will once again be integrated as tab in 
the GUI. 
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18 Setting values 

18.1 Setting the values of a component from the user 
interface 

The RiZone user interface serves not only for querying of data using SNMP, 
values such as thresholds for temperature sensors can also be set. This 
function is available only in view mode and the logged-in user requires the 
necessary authorisations. 
To set or change a value, proceed as follows: 

• Right-click to select the component/sensor in the project tree and 
select Variables in the context menu. The variable view of the 
component now opens in the View window. 

 
• Now click the Set button after the variable value in the View window 

that you want to change.  

 
• You can change the value either by the direct input of the value or 

using the slider in the Set value window that now opens. The slider 
specifies the permitted value range to be selected. 
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If only certain values are permitted, a drop-down menu lists all 
possible inputs here. 

• After changing the value, click the Set button to transfer the value to 
the component. 

• Once the value has been written successfully, it will be displayed 
immediately in the View window. 

 
 

 

 

Note! 

To set one or more values, the IP of the RiZone 
server must be entered as trap receiver in the 
component (e.g. CMC Processing Unit II). If this 
is not the case, the component does not accept 
any values from the RiZone server. 

 

 

Note! 
If the value cannot be set, an error message will 
indicate this situation. In this case, the value 
must be reset and Set clicked to reinitiate the 
action. 
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18.2 Setting several values simultaneously 
In addition to the setting of individual values, the RiZone user interface can 
also be used to change several values simultaneously.  

• Right-click to select the component/sensor in the project tree and 
select Variables in the context menu. The variable view of the 
component now opens in the View window. 
 

 
 

• Now select in the View window all values that are to be changed 
simultaneously. To do this, click successively all variables to be 
changed while keeping the Ctrl key pressed. It is also possible to 
mark an area by pressing the Shift key. 
 

 
 
• Now click the Set button for one of the selected variables. 
• The Set value dialog for several values opens. 
• To set values simultaneously, the selection box in front of each 

selected variable must be set. 
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• Now enter the value to be used for all selected variables as New 
value and click Set value to confirm. 
 

 
 

 

Caution! 
Only the same variable types can be set with a 
multiple selection. 
Select the same variable types, such as 
VoltageCxPx_SetLow 
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• Once the values have been written successfully, they will be 

displayed immediately in the View window. 
 

 
 
 
 

 

Note! 
If the trap receiver for the PU is not configured 
on the RiZone server, the changes will not be 
transferred to the RiZone server. The PU must be 
rediscovered and replaced in the project tree. 

 
 
 

19 Configuration of the SNMP devices 
The SNMP devices are configured during the configuration and in the 
running project. During the configuration, the variables of the discovered 
devices are configured. 
The SNMP communication will be activated when the project is started. If the 
project has been started, the individual devices can be configured. 

19.1 Configuration of variables 
In addition to the SNMP-polled variables, variables can also be created 
manually. Their value can be calculated using arithmetic operations for 
polled or other manually-created variables. This makes it possible, for 
example, to create a variable that calculates the total power consumption of 
a rack when the individual values are fetched in RiZone with SNMP polling. 
For the configuration of a variable, the GUI must be in admin mode and a 
device in the project tree selected. A right-click on the variable opens the 
context menu. The Variables option will be selected. The variables window 
of the selected component opens in the main window (View window) of the 
RiZone GUI. If required, click Down arrow to open the variables list. 
 

 
 

56 RiZone 

 



EN

19 Configuration of the SNMP devices 
 

RiZone  57 

 

 

Fig. 40  Configuration of variables 

 
The mouse can now be used to select a variable. A right-click opens the 
context menu.  

 The New variable menu item is not required for the configuration of 
Rittal components because RiZone automatically discovers all 
variables of the components. 

The Edit variable menu item permits the configuration of the automatically 
discovered variables of a Rittal component.  
The Shift and Ctrl keys can be used to select multiple variables. Only the 
selected field is refreshed for a multiple selection. All other fields remain 
unchanged. 
The following variables can be configured for the configuration: 

• Interval 
• Group 
• Description 
• Unit 
• Display factor 
• Display format 
• Publish (forward the value of the variable to higher-level 

management systems if an appropriate interface is activated, such 
as the SCOM Management Pack) 

To ensure correct operation, no other settings may be changed. 
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Name Name of the variable 
Description Description of the variable 
Publish If set, the variable will be passed to the Messaging 

Service. 
Interval Specifies the calculation cycle (in seconds). Off 

means that the variable will be calculated once after 
the project is uploaded. 

Physical 
measurement 
quantity 

Specifies the measurement quantity of the variable 

Unit Specifies the unit of the variable 
Display factor Display factor of the variable 
Display format ,n:m  

where n specifies the number of digits before the 
decimal point and m the number of digits after the 
decimal point. Example: ,5:0.00 -> five digits before 
the decimal point and two digits after the decimal 
point. 

Group Selection of the group of the variable. 
The selection of the group affects the group status 
variables of the component to which the variable in 
the project is assigned. If the variable is assigned to a 
group and changes its status, the group status 
variable of the higher-level infrastructure component 
also changes its status to that of the variable 
(Exception: Another variable has already raised the 
status of the group status variable to a critical status). 

 
  

 
Fig. 41  Changing variables 
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19.2 Configuration of SNMP devices 
The SNMP devices are configured in the running project; the logged-in user 
must have the appropriate rights. A device is selected in the project tree. A 
right-click on the selected component opens the associated context menu. 
The Variable menu item can now be selected. The variables list of the 
component opens in the RiZone GUI main window. 

19.2.1 Component name 
The component name is configured by selecting Name and clicking the Set 
button. Ensure that the name of the component is not longer than the 
maximum character length. Please observe here the operating instructions 
of the component used. 

 

Fig. 42  Name of the component 

 
 
 

 

 

 

 

 

 

 

 

Fig. 43  Component name value input 
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19.2.2 Location name 
The location name is configured by selecting Location and clicking the Set 
button. Ensure that the name of the location is not longer than the maximum 
character length. Please observe here the operating instructions of the 
component used. 
 

Fig. 44  Location name 

 
 
 
 

 

 

 

 

 

 

 

 

 Fig. 45  Location name value input 
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19.2.3 Contact name 
The contact name is configured by selecting Contact and clicking the Set 
button. Ensure that the name of the contact is not longer than the maximum 
character length. Please observe here the operating instructions of the 
component used. 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 46  Contact name 

 
 
 
 

 

 

 

 

 

 

 

 

 Fig. 47  Contact name value name 
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19.2.4 Quit 
The Quit function permits the automatic acknowledgement of a message and 
the confirmation of configuration changes for the CMC-TC system. The Set 
button enables and disables the function.  
The "Quit", "No quit" and "Restart" functions can be selected. 
Quit: The message will be acknowledged. 
No quit: The message will not be acknowledged. 
Restart: The Processing Unit will be booted. 

 
Please observe here the operating instructions of the component used. 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Fig. 48  Activating the Quit function 
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19.2.5 Trap enable 1-4 
The Trap enable function is used to activate/deactivate the trap receiver. 
The Set button enables and disables the function. Please observe here the 
operating instructions of the component used. 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Fig. 49  Trap enable function  

 
 
 

 

 

 

 

 

 

 

Fig. 50  Trap enable value selection 
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19.2.6 Trap receiver 1-4 
The Trap receiver function is used to configure the trap receiver. The Set 
button is used to configure the IP address of the trap receiver. Please 
observe here the operating instructions of the component used. 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Fig. 51  Configuring the trap receiver 

 
 
 
 

 

 

 

 

 

 

 

 Fig. 52  Entering the IP address of the trap receiver 

 

64 RiZone 

 



EN

19 Configuration of the SNMP devices 
 

RiZone  65 

 

19.2.7 Configuring a value 
The Set button is used to set a value. Please observe here the operating 
instructions of the component used. 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Fig. 53  Setting values (general) 
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20 Replacement of a device 
RiZone allows the replacement of a device in the project tree without 
changing the configured properties. Ensure that the device type and the 
configuration of the devices are identical. 
Procedure: 

• Selection of the new device 
Left-click the device to mark it in the Discovery window. 

• Moving the device into the project tree 
Drag the device with pressed Alt key to the device to be replaced. 
The variables with the same IDs will be transferred. The message 
that now appears must be confirmed. 
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21 Messaging service (optional) 
Provided activated with the licence key (optional), RiZone offers with the 
messaging service the capability to transfer not only the status of 
components but also individual, published variables to a higher-level network 
management system with the SNMP protocol. 
The status of a component will be forwarded automatically to the messaging 
service. 

21.1 Configuring a variable for the messaging service 
During the creation or editing of a project, the Publish checkbox can be 
activated for the editing of a variable. If this checkbox is activated, the 
variable will be passed to the messaging service. To activate the changes, 
the changed project must be uploaded to the RiZone server. 

21.2 SNMP configuration 
The SNMP agent tab is selected in the Administration > Messaging 
service menu. The Activate SNMP agent checkbox activates the service 
for connection to a network management system. 
The Reinitialise SNMP agent checkbox re-establishes the dynamic MIB for 
RiZone. This function can be used to delete the OID in the MIB when a 
variable is no longer published. 
If the MIB is re-established, this can lead to integration incompatibilities of 
RiZone in the network management system. 

21.2.1 Network 
The Network menu can be used to assign the rights for the SNMP access. 
The configuration for the Read community and Write community controls 
this authorisation. This setting must be identical with that in the management 
system. The access from arbitrary management systems can be permitted 
when the Read and Write community fields are empty. 

21.2.2 MIB-II 
Settings are made in the MIB-II menu to identify the RiZone server using 
SNMP. 
SysName: SNMP name of the RiZone server 
SysLocation: Location of the RiZone server 
SysContact: System officer 
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21.2.3 Trap 
RiZone supports a maximum of two trap recipients. These can be configured 
as Trap recipient 1 and Trap recipient 2. 

21.3 Specification of the MIB 

 

mgmt.mib-2.system – Data for identifying the computer. In accordance with 
the MIB specification, some data can be written. For deviations between the 
SNMP agent and the setting dialog, the dialog data is used (to view the 
changes in the setting dialog, the dialog must be closed and re-opened). 
private.enterprises.rittal.riZone.rizoneMibRev – version details of the 
used MIB. Currently 1.0. 
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private.enterprises.rittal.riZone.rizoneMibRev.riZoneMibCondition – 
status of the complete system 
other (1), 
ok (2), 
degraded (3), 
failed (4), 
configChanged (5) 
private.enterprises.rittal.riZone.rizoneMibRev.riZoneModule – status 
and version of the installed RiZone server 
private.enterprises.rittal.riZone.rizoneMibRev.riZoneProject – project 
name and timestamp of the last change 
private.enterprises.rittal.riZone.rizoneMibRev.riZoneStatus – status of 
the components and variables contained in RiZone. The overall status of the 
project can also be queried specifically. This corresponds to the status of the 
uppermost project node. 
  
Component table 
All RiZone components are always available in the component list. 

  
Component Index – table index 
Component Id – RiZone ID of the component 
Component Name – RiZone component name 
Component Type – 
removed (1), 
domain (2), – row is no longer used 
location (3), 
building (4), 
room (5), 
rackrow (6), 
rack (7), 
device (8), – component represented by a driver (CMC, LCP, DRC, UPS ...) 
server (9) 
  
Component Parent – ID of the higher-level component in the RiZone 
locations tree 
Component Status Total – overall status of Availability, Cooling, Power, 
Monitoring and Security  
  
Variables table 
The variables list contains all variables that have activated the Publish 
option in the properties. 
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Note! 

The table will be updated when the "Reinitialise 
SNMP agent" function has been executed. If the 
function is not called, values may remain in the 
table that are no longer present in the RiZone 
project or should no longer be published. 

 
Variable Index – table index. 
Variable ID – RiZone ID of the variable. 
Variable Name – Name from the RiZone variable list. 
Variable Maintenance Group – specifies to which group the status belongs. 
This is a bit-coded field. 
undefined(1), 
cooling(2), 
power(4), 
rack(8), 
monitoring(16), 
remoting(32), 
availability(64), 
security(128)  
Variable Unit – specifies the physical measurement unit. This does not 
determine the factor (mW, W, KW). 
undefined(1), 
temperature(2), 
current(3), 
power(4), 
effectivPower(5), 
humidity(6), 
voltage(7), 
energy(8), 
frequency(9), 
access(10), 
leakage(11), 
percent(12), 
rpm(13), 
co2(14), 
pue(15), 
flow(16), 
time(17), 
costs(18), 
imp(19) 
Variable Parent ID – RiZone ID of the component to which the variable is 
assigned. 
Variable Type – specifies the data type. 
number(1), 
string(2), 
enum(3) 
Variable Quality – validity of the measured value. 
undefine(1), – value is not yet initialised. This can occur at the restart of the 
RiZone server. 
good(2), – value is OK. 
bad(3), – the value could not be determined (e.g. timeout). These values do 
not represent the current status and cannot be used for calculations. 
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Variable Value Int – integer value of the variable (type number or enum) 
Variable Value String – written out value. For (type = number) the value 
taking account of the factors and a point as decimal separator. For (type = 
enum) the significance of the value, e.g. Int=4 > String="OK". 
Variable Value Unit – measurement unit of the (Int value * 
multiplicand/divisor) e.g. (W, kW, mA, °C) 
Variable Divisor – divisor of the value (e.g. value = 333 ; divisor = 10 ; unit 
= °C gives 33.3°C) 
Variable Multiplicand – multiplicand of the value. 
  
Trap 
The RiZone MIB integrates a "projectUpload" trap. This is sent for each 
upload from a project to the entered trap receiver. The content of the trap 
are variables from the tree listed above – sysContact, sysName, 
sysLocation, riZoneProjectName, riZoneProjectChangeTime. 
  
FAQs 
There is no setting dialog for the SNMP agent. 
Check your licence whether the SNMP agent is activated. 
  
No message arrives in RiZone whether the SNMP agent has been 
started. 
Activate "Activate SNMP agent". You must now receive a message in the 
RiZone message list. If not, check whether the Messaging Service is 
running. (As of version 1.3, the Messaging Service is a Windows service). 
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22 Update and deinstallation of the RiZone GUI 

22.1 Update of the RiZone GUI 
The RiZone GUI is updated by the deinstallation and the installation of the 
new GUI. 
Detailed information is provided in the Installation and Deinstallation sections 
of the GUI. 

22.2 Deinstallation of the RiZone GUI 
The RiZone GUI is deinstalled locally from the client PC control panel. 
Example Windows XP: The control panel is opened and the Software menu 
item selected. Then select the Rittal RiZone GUI program.  
 
 

22.3  Installing the RiZone GUI 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig. 54  Deinstallation of the RiZone GUI 

 
Click the Remove button to prepare the deinstallation of RiZone.  
 
 
 
 
 
 
Fig. 55  Deinstallation of the RiZone GUI 
 
The confirmation of the prompt causes the deinstallation to be performed. 
 
A deinstallation under Vista or Windows 7 is performed similarly. 

72 RiZone 

 



EN

23 Technical specifications 
 

RiZone  73 

 

23 Technical specifications 

23.1 Virtual hard disk (Software Appliance) technical 
specifications 

System requirements  

CPU 2 GHz dual core processor  

RAM 4 GB 

Hard disk capacity 70 GB 
Network 1 Gbit SNMP 

1 Gbit Fileshare/Management 
Supported hypervisors VMWare, Xen, Hyper-V 
Client operating system Windows 2008 Server R2 64-bit 
Ports used  161, 162, 800, 3389, 4433, 22222, 

22223 
 

23.2 Hardware Appliance technical specifications 
CPU 1.86 GHz Xeon dual core processor  

RAM 4 GB 

Hard disk capacity 2 x 250 GB (RAID 1) 
Network 2 x 1 Gbit Ethernet 
Operating system Windows 2008 Server R2 64-bit 
Ports used  161, 162, 800, 3389, 4433, 22222, 

22223 
 
 
 



Power Distribution
Stromverteilung

Distribution de courant
Stroomverdeling
Strömfördelning
Distribuzione di corrente
Distribución de corriente

IT Solutions
IT-Solutions

Solutions IT
IT-Solutions
IT-lösningar
Soluzioni per IT
Soluciones TI

System-Klimatisierung
System Climate Control
Climatisation
Systeemklimatisering
Systemklimatisering
Soluzioni di climatizzazione
Climatización de sistemas

Schaltschrank-Systeme
Industrial Enclosures
Coffrets et armoires électriques 
Kastsystemen
Apparatskåpssystem
Armadi per quadri di comando
Sistemas de armarios

Elektronik-Aufbau-Systeme
Electronic Packaging
Electronique
Electronic Packaging Systems
Electronic Packaging
Contenitori per elettronica
Sistemas para la electrónica

Communication Systems
Communication Systems
Armoires outdoor
Outdoor-behuizingen
Communication Systems
Soluzioni outdoor
Sistemas de comunicación
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